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Merci d’avoir choisi la carte réseau sans fil 54g pour ordinateurs de bureau de
Belkin (la carte). Vous pouvez désormais profiter de cette nouvelle technologie
incroyable et vous déplacer librement chez vous ou dans votre bureau sans vous
préoccuper des câbles. La carte réseau sans fil pour ordinateurs de bureau
fonctionne comme une carte réseau conventionnelle, mais sans câble. Vous serez
prêt à communiquer en réseau en quelques minutes grâce à la simplicité de
l’installation et de la configuration. Lisez attentivement l’ensemble de ce manuel
afin d’être certain de tirer le meilleur parti de votre carte réseau sans fil pour
ordinateurs de bureau.
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PRÉSENTATION

Applications et avantages

• Connexion sans fil chez vous ou au bureau
Permet une liberté de mise en réseau sans la gène liée aux câbles.

• Connexions jusqu’à 54 Mb/s
Permet une connectivité immédiate sans fil et à vitesse élevée chez vous, au
bureau et depuis différents points d’accès sans compromettre l’utilisation des
produits 802.11b existants.

• Compatibilité avec les produits 802.11b
Les solutions LAN sans fil 54g sont rétrocompatibles avec les produits Wi-Fi
(IEEE 802.11b) existants ainsi qu’avec d’autres produits arborant le logo 54g.

• Environnements impropres au câblage
Permet de créer un réseau dans des bâtiments comportant des murs pleins ou
dans des zones ouvertes où le câblage est difficile à effectuer.

• Environnements changeants
S’adapte facilement aux bureaux ou aux environnements souvent réorganisés,
ou lorsque vous changez souvent de site.

• LAN temporaires lors de projets ponctuels ou en cas d’activité accrue
Permet de créer un réseau temporaire lors d’une foire, d’une exposition ou d’un
chantier à court terme. Idéal pour les sociétés ayant besoin de postes de
travail supplémentaires en période d’activité accrue.

• Mise en réseau pour particuliers ou petites entreprises
Permet l’installation simple et rapide d’un petit réseau à usage privé ou pour
petites entreprises.

PRÉSENTATION

2

Caractéristiques
La carte est conforme à la norme IEEE 802.11b pour communiquer avec d’autres
périphériques sans fil 802.11b à 11 Mb/s ainsi qu’avec d’autres produits 54g à
54 Mb/s portant le logo 54g™ sur l’emballage.

Les produits 54g fonctionnent à des vitesses pouvant atteindre 54 Mb/s et sur la
même bande de fréquence de 2,4 GHz que les produits 802.11b Wi-Fi.

• Fonctionnement dans la bande ISM (Industrial, Science, Medical) 2,4 GHz

• Utilitaire de configuration sans fil intégré et convivial

• Interface sans fil conforme à la norme IEEE 802.11b et compatible avec les
produits 54g

• Interface PCI pour utilisation avec pratiquement tout ordinateur de bureau

• Cryptage sans fil (WEP) 64 ou 128 bits

• Accès sans fils aux ressources du réseau

• Prise en charge des modes réseau Infrastructure et Ad-Hoc (poste à poste)

• Débit de données jusqu’à 54 Mb/s

- Prend en charge des taux de 11/5,5/2 ou 1 Mb/s (802.11b)

- Prend en charge des taux de 54, 48, 36, 24, 18, 12, 9 ou 6 Mb/s (54g)

• Facile à installer et à utiliser

• Antenne externe

• Voyants lumineux d’alimentation et de liaison réseau

3
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PRÉSENTATION DE LA CARTE

(a) Voyant lumineux d’alimentation
Lorsque la carte reçoit du courant, ce voyant est allumé.

(b) Voyant de liaison
Lorsque le carte est reliée à un réseau sans fil, le voyant émet une lumière
continue. Lorsqu’elle n’est pas reliée à un réseau sans fil, la lumière clignote
lentement.

(c) Connecteur de la carte
Côté de la carte à insérer dans l’emplacement PCMCIA de votre portable

(d) Antenne

PRÉSENTATION

Spécifications du produit
Interface hôte : PCI 32 bits

Consommation électrique : Pointe transmission/réception
550/350 mA à 3,3 V CC (max.)

Certification : FCC Classe B, Homologation CE, C Tick

Température de fonctionnement : 0 à 85° C

Température de stockage : -40 à 90° C

Humidité : 95 % max. (sans condensation)

Portée de fonctionnement habituelle : 802.11b : 180 m à 11 Mb/s, 300 m à 5,5
Mb/s ou moins

54g : 50 m à 54 Mb/s, 150 m à 18 Mb/s

Configuration requise
• Ordinateur compatible PC avec un emplacement PCI libre

• Windows® 98, 2000, Me, XP

Contenu
• Carte réseau sans fil 54g pour ordinateurs de bureau de Belkin

• Guide d’installation rapide

• CD d’installation du logiciel

• Manuel de l’utilisateur

54

(d)

(a)

(c)

(b)
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L’installation de la carte comporte trois étapes simples :

1. Installez le logiciel EN PREMIER. Si vous installez la carte dans le PC avant
d’installer le logiciel, elle ne fonctionnera pas.

2. Installez la carte dans le PC.

3. Allumez le PC et laissez le système d’exploitation Windows terminer
l’installation de la carte.

Remarque : Installez le logiciel en premier avant d’installer la carte dans
l’ordinateur.

Installation du logiciel et des pilotes
1. Insérez le CD dans le lecteur de CD-ROM.

2. L’écran « Wireless Desktop Network Card Setup Utility » (Utilitaire
d’installation de la carte réseau sans fil pour ordinateurs de bureau) apparaît
automatiquement. S’il n’apparaît pas dans un laps de temps de 15 à
20 secondes, sélectionnez votre lecteur de CD-ROM, puis cliquez deux fois sur
le dossier « Files » (Fichiers). Ensuite, cliquez deux fois sur l’icône
« F5D7000_UTILITY.exe ».

3. Dans l’écran de l’utilitaire, faites glisser la souris sur le bouton « Install »
(Installer), puis sélectionnez « Click here » (Cliquez ici) pour lancer le
programme d’installation du logiciel.

INSTALLATION ET CONFIGURATION DE LA CARTE

4. Le programme d’installation démarre. Si vous utilisez Windows XP, nous vous
conseillons d’employer l’utilitaire de carte réseau sans fil pour ordinateurs de
bureau de Belkin pour gérer les paramètres sans fil de la carte. Si vous voulez
vous servir de Windows XP pour gérer la carte, cochez la case « Use the
Windows XP Wireless Network Connection Utility » (Utiliser l’utilitaire de
connexion réseau sans fil de Windows XP). Vous pourrez vous procurer des
instructions sur le fonctionnement de cet utilitaire auprès de Microsoft.
Cliquez sur « Next » (Suivant) pour continuer.

5. Pour accepter les termes du contrat de licence Belkin, cliquez sur « YES »
(Oui).

INSTALLATION ET CONFIGURATION DE LA CARTE

6 7
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INSTALLATION ET CONFIGURATION DE LA CARTE

7. Une fois l’installation du logiciel terminée, cliquez sur « Finish » (Terminer).
Vous êtes maintenant prêt à installer le matériel.

8. Retirez le CD du lecteur de CD-ROM et mettez l’ordinateur hors tension.

Remarque : Veillez à quitter correctement Windows en cliquant sur « Start »
(Démarrer), puis sur « Shut Down » (Arrêter).

INSTALLATION ET CONFIGURATION DE LA CARTE

6. Sélectionnez le dossier dans lequel vous souhaitez installer les fichiers du
programme. Nous vous conseillons d’utiliser le dossier par défaut « C:\Program
Files\Belkin\Belkin 54Mbps Wireless Utility\ ». Cliquez sur « Next » (Suivant)
pour installer les fichiers.

Remarque : Il se peut que, pendant l’installation, un message vous demande
d’insérer la carte. Si ce message ne disparaît pas automatiquement après cinq
secondes, cliquez sur le bouton « Cancel » (Annuler) pour continuer.

8 9
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INSTALLATION ET CONFIGURATION DE LA CARTE

11

10. Remettez le carter de l’ordinateur en place.

11. Maintenant que la carte est installée, vous pouvez replacer le carter sur
l’ordinateur, rebrancher tous les câbles et le remettre sous tension. Passez à
la section « Fin de l’installation ».

Fin de l’installation
1. Allumez l’ordinateur.

2. Selon le système d’exploitation utilisé, il se peut que Windows détecte la carte
et lance l’assistant « Found New Hardware » (Nouveau matériel détecté).
Cliquez sur « Next » (Suivant).

INSTALLATION ET CONFIGURATION DE LA CARTE

Installation de la carte dans l’ordinateur sous Windows 98, Me, 
2000 et XP
1. ÉTEIGNEZ L’ORDINATEUR ET DÉBRANCHEZ LE CORDON D’ALIMENTATION.

2. Retirez les vis de fixation du carter de l’ordinateur, puis retirez le carter.

3. Touchez un élément métallique du châssis. Cette manipulation permet de vous
décharger de toute électricité statique qui risquerait d’endommager le produit
ou votre ordinateur.

4. Recherchez une extension PCI libre.

5. Vérifiez que la carte est adaptée à l’emplacement choisi. N’oubliez pas que
l’antenne incluse doit être orientée partie supérieure vers le haut. Si des
câbles ou d’autres connecteurs se trouvent sur le chemin, choisissez
l’emplacement PCI qui présente le moins d’obstructions afin de permettre le
positionnement correct de l’antenne.

6. Retirez l’obturateur du port à l’arrière du PC correspondant à l’emplacement
PCI sélectionné. Si cet obturateur est muni d’une vis, placez-la dans un
endroit sûr, car vous l’utiliserez plus tard pour fixer la carte au châssis.

7. Poussez la carte fermement dans l’emplacement PCI choisi. Appuyez
suffisamment afin que le connecteur soit bien en place.

8. Fixez maintenant la carte à l’aide de la vis que vous aviez mis de côté.

9. Vissez avec précautions l’antenne sur le connecteur fileté de la carte. Tournez
l’antenne jusqu’à ce qu’elle soit en position verticale et orientée vers le haut.

10 11

P74216fr_F5D7000_man.qxd  07-03-2003  15:27  Page 10



INSTALLATION ET CONFIGURATION DE LA CARTE

13

5. Il se peut qu’un message de Windows vous demande de redémarrer votre
ordinateur. Si tel est le cas, cliquez sur « Yes » (Oui) ou sur « Restart »
(Redémarrer).

6. Lorsque l’ordinateur redémarre, une icône apparaît dans l’angle inférieur droit
de l’écran. Voir ci-dessous :

Icône verte : Connecté à un réseau sans fil, bonne connexion.

Icône jaune : Connecté à un réseau sans fil, connexion acceptable.

Icône rouge : Pas de connexion au réseau sans fil.

Remarque : L’icône de l’utilitaire LAN sans fil apparaît également dans le Panneau
de configuration. Pour ouvrir l’utilitaire LAN sans fil, cliquez deux fois sur cette
icône.

7. L’installation est terminée. Reportez-vous au manuel de l’utilisateur pour
configurer et utiliser l’utilitaire sans fil de Belkin.

INSTALLATION ET CONFIGURATION DE LA CARTE

12

3. Il se peut qu’un message de Windows vous demande d’indiquer l’emplacement
des pilotes. N’apportez aucune modification et cliquez sur « Next » (Suivant).

Remarque : Si vous utilisez Windows 2000 ou XP, vous obtiendrez un message
vous indiquant que les pilotes ne sont pas certifiés par Microsoft. Cela ne signifie
pas que Windows a rencontré un problème. Cliquez sur « Continue » (Continuer).

4. Windows trouve le fichier de pilote adapté et termine l’installation. Il se peut
qu’un message de Windows vous indique que le matériel est installé.
Cliquez sur « Finish » (Terminer) si cela vous est demandé.
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UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

Procédez comme suit pour configurer vos profils réseau. Les instructions vous
expliquent comment ouvrir l’utilitaire et comment l’utiliser pour configurer un
profil réseau.

Lorsque vous lancez l’utilitaire LAN sans fil (l’utilitaire), l’écran « Connect to
Wireless Network » (Raccordement au réseau sans fil) apparaît.

La petite icône suivante figurera également dans la barre des tâches.

Une fois installé, l’utilitaire LAN sans fil s’affichera automatiquement au
démarrage de Windows.

Il est possible de définir l’utilitaire de sorte qu’il apparaisse toujours dans la
barre d’état système. Pour masquer l’icône, cliquez dessus avec le bouton droit de
la souris dans la barre d’état système. Bien qu’aucune icône ne soit affichée,
votre réseau préféré continuera à être géré par la carte. L’icône de la barre d’état
système peut être réactivée à partir de l’utilitaire de configuration LAN sans fil
que vous trouverez dans le Panneau de configuration.

Cliquez une seule fois sur l’icône de la barre d’état système pour ouvrir la fenêtre.

Remarque : Vous pouvez cliquer deux fois sur l’icône de l’utilitaire de la barre
d’état système pour ouvrir directement la fenêtre « Advanced Configuration »
(Configuration avancée).

INSTALLATION ET CONFIGURATION DE LA CARTE

14

Raccordement au réseau sans fil
Si vous disposez déjà d’un routeur sans fil ou d’un point d’accès chez vous ou au
bureau, la carte essayera automatiquement de se connecter à votre réseau sans
fil. La plupart du temps, elle pourra se connecter automatiquement au réseau. Si
votre réseau sans fil utilise le cryptage, vous devrez définir des paramètres de
cryptage pour votre carte qui correspondent à ceux de votre réseau sans fil. Pour
plus d’informations sur la configuration de votre carte, reportez-vous à la
prochaine section du manuel.

Désinstallation du logiciel et des pilotes
Si vous devez supprimer le logiciel et les pilotes pour une raison quelconque,
vous pouvez le faire facilement de l’une des manières suivantes. Vous pouvez
insérer le CD du logiciel, puis cliquer sur l’option « Uninstall » (Désinstaller) dans
le menu. Vous pouvez également ouvrir le Panneau de configuration de Windows
et sélectionner l’option « Add/Remove Programs » (Ajout/Suppression de
programmes). L’assistant Belkin vous guidera à travers le processus de
suppression.

14 15
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Remarque : Sous Windows XP, lorsque vous cliquez sur le bouton « Advanced »
(Avancé) pour la première fois, la fenêtre suivante apparaît. L’option « Use Windows
to configure my wireless network settings » (Utiliser Windows pour configurer mes
paramètres réseau sans fil) est activée par défaut. Cliquez sur la case pour la
désélectionner et utiliser l’utilitaire réseau sans fil de Belkin à la place.

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKINUTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

L’utilitaire détecte automatiquement tous les réseaux 802.11b et 54g qui se
trouvent dans la zone. Sélectionnez un réseau disponible parmi ceux répertoriés,
puis cliquez sur le bouton « Connect » (Connecter) afin de vous connecter à ce
réseau.

Si la fonction de cryptage WEB est activée sur le réseau sans fil auquel vous
souhaitez vous connecter, la zone de texte « Network key » (Clé réseau) sera
active. Entrez la clé réseau correspondante afin d’établir la connexion.

Cliquez sur « Cancel » (Annuler) ou quittez le programme.

Le bouton « Advanced » (Évolué) vous permet d’afficher et de configuration un
plus grand nombre d’options de la carte.

1716
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UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

(c) Preferred Networks (Réseaux préférés)
Affiche la liste des réseaux que vous avez configurés. Pour ordonner les réseaux,
sélectionnez un nom de réseau dans la liste « Preferred Networks » (Réseaux
préférés), puis cliquez sur les boutons « Move UP » (Monter) et « Move Down »
(Descendre). Les réseaux apparaissant en début de liste auront la préférence par
rapport à ceux qui figurent plus loin dans la liste. Si un réseau préféré n’est pas
disponible, la carte essaie d’établir une connexion avec le réseau suivant de la
liste.

Remarque : Vous devez cliquer sur le bouton « Apply » (Appliquer) pour que les
changements soient pris en compte.

(d) Preferred Network (Réseau préféré)
La bulle bleue qui figure sur l’icône d’un réseau indique que vous êtes
actuellement connecté à ce réseau.

(e, f) Add, Remove (Ajouter, Supprimer)
Cliquez sur le bouton « Add » (Ajouter) (e) et « Remove » (Supprimer) (f) pour
ajouter des réseaux dans la liste des réseaux préférés ou pour en supprimer.

(g) « System Tray Icon » (Icône sur la barre d’état système)
Cochez cette case de manière à ce que l’icône sans fil apparaisse au niveau de la
barre d’état système.

(h) Properties (Propriétés)
Pour vérifier les propriétés et les paramètres WEP du réseau préféré, sélectionnez
un réseau, puis cliquez sur le bouton « Properties » (Propriétés).

19

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

Onglet « Wireless Networks » (Réseaux sans fil)

(a) Enable Radio (Activer la radio)

Utilisez cette option pour activer/désactiver la radio réseau sans fil. Vous devrez
peut-être désactiver la radio lorsque vous serez en avion ou pour rallonger la
durée de vie de la batterie de votre ordinateur portable. Lorsque la radio est
désactivée, le voyant lumineux de la carte est éteint et l’icône du réseau sans fil
de la barre d’état système apparaît sous la forme d’un « X ».
(b) Available Networks (Réseaux disponibles)

Affiche la liste de tous les réseaux sans fil disponibles dans votre secteur. Pour
sélectionner un réseau, cliquez sur son nom ou sur le bouton « Refresh »
(Actualiser) (j) afin de procéder à une nouvelle recherche de réseaux sans fil
disponibles dans votre zone et auxquels vous pouvez vous connecter.

Une fois un réseau choisi, cliquez sur le bouton « Configure » (Configurer) (i).
Cliquez sur « OK » dans la zone « Wireless Network Properties » (Propriétés du
réseau sans fil). Le nom du réseau et l’icône apparaissent en début de la liste
« Preferred Networks » (Réseaux favoris) (c). Attendez une minute pour que la
connexion réseau soit établie. L’ordinateur est connecté au réseau sélectionné
lorsque vous voyez une bulle bleue sur l’icône correspondant à ce réseau.

(a)

(b)

(c)

(d)

(e)

(f)

(g)
(h)

(i)

(j)

(k)

(l)

18 19

P74216fr_F5D7000_man.qxd  07-03-2003  15:27  Page 18



UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

Cryptage
Pour configurer le profil d’un réseau répertorié nécessitant une clé WEP :

1. Une fois l’utilitaire ouvert, sélectionnez le réseau dans la liste « Available
networks » (Réseaux disponibles), puis cliquez sur « Configure » (Configurer).

2. Cochez la case « Data encryption (WEP enabled) » (Cryptage des données avec
activation WEP).

3. Désélectionnez la case « The key is provided for me automatically » (La clé est
fournie automatiquement).

4. Entrez la clé réseau dans la zone « Network key » (Clé réseau).

Remarque : Il est inutile de sélectionner « Key format » (Format de la clé) ou
« Key length » (Longueur de la clé) avant d’entrer la clé réseau. En effet, ces
paramètres changent automatiquement et adoptent la valeur appropriée lorsque
vous entrez la clé réseau.

5. Cliquez sur « OK ».

Remarque : Vous devez cliquer sur le bouton « Apply » (Appliquer) pour que les
changements soient pris en compte.

(l) Advanced (Avancé)
Permet de filtrer le type de réseau auquel vous souhaitez vous connecter.

« Any Available Network » (Tout réseau disponible) : lorsque vous
choisissez cette option, la carte essaye d’établir une connexion à tout
réseau disponible dans la zone. Les points d’accès seront préférés par
rapport aux réseaux ad-hoc.

« Access Point Networks Only » (Réseaux avec point d’accès uniquement) :
lorsque vous choisissez cette option, la carte essaye d’établir une connexion
à tout point d’accès disponible dans la zone. Lorsque cette option est
sélectionnée, les réseaux ad-hoc sont exclus de la liste des réseaux
disponibles.

« Computer-to-Computer Networks Only » (Réseaux poste à poste
uniquement) : lorsque vous choisissez cette option, la carte essaye d’établir
une connexion à tout réseau ad-hoc disponible dans la zone. Lorsque cette
option est sélectionnée, les points d’accès sont exclus de la liste des réseaux
disponibles.

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

2020 21
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UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

(e) Channel (Canal)
Montre le canal de fonctionnement actuel de la carte. En mode Infrastructure, le
canal est automatiquement défini par le point d’accès ou le routeur sans fil
auquel est relié la carte. Il est impossible de changer de canal en mode
Infrastructure. En mode Ad-Hoc, vous pouvez définir le canal manuellement.

(f) Client IP Address (Adresse IP du client)
Indique l’adresse IP de votre client sans fil. Par défaut, l’adresse IP est obtenue
automatiquement. Vous pouvez la définir manuellement en vous servant des
propriétés réseau de Windows.

(g) Network Connection Type (Type de connexion réseau)
Montre le mode sans fil actuel dans lequel fonctionne la carte. Il en existe deux :
Infrastructure et Ad-Hoc. Infrastructure est le mode de fonctionnement le plus
courant. Il est employé lorsque vous raccordez votre PC à un point d’accès sans
fil ou à un routeur sans fil. Le mode Ad-Hoc permet de relier deux ordinateurs ou
plus sans utiliser de point d’accès ou de routeur sans fil.

(h) Radio State (État de la radio)
Indique si l’adresse IP de votre client sans fil est activée ou désactivée. Par
défaut, l’adresse IP est obtenue automatiquement. Vous pouvez la définir
manuellement en vous servant des propriétés réseau de Windows.

(i) Signal Strength (Force du signal)
Affiche la force du signal sans fil de 0 à 100 %. Plus le signal est proche de
100 %, plus il est fort. Plus vous êtes proche d’un routeur sans fil ou d’un point
d’accès, plus le signal sera fort.

(j) « Link Quality (Noise) » (Qualité de la liaison - Bruit)
Affiche la quantité d’interférences radio dans l’environnement. Les niveaux faibles
sont optimums.

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

Onglet Link Status (État de la liaison)

(a) SSID
Le SSID est le nom du réseau sans fil. Ce champ affiche le SSID actuel auquel la
carte est associée. La carte recherche automatiquement un réseau sans fil dans la
zone. Pour vous connecter à un réseau sans fil spécifique, vous pouvez
sélectionner manuellement le SSID du réseau sans fil connu dans l’onglet
« Wireless Networks » (Réseaux sans fil).

(b) MAC Address (Adresse MAC)
Affiche l’adresse MAC du réseau sans fil auquel vous êtes connecté.

(c) WEP
Indique si la fonction de cryptage WEB est activée ou désactivée sur le réseau
auquel vous êtes associé.

(d) Speed (Vitesse)
Affiche le débit de données de la connexion actuelle.

(a)

(b)

(c)

(d)

(e)

(g)

(h)
(i)

(j)

(f)
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Onglet Site Survey (Surveillance du site)
Pour obtenir la liste de tous les points d’accès disponibles dans votre zone,
cliquez sur l’onglet « Site Survey » (Surveillance du site). Voici les informations
affichées :

(a) SSID
Service Set Identifier (nom du réseau sans fil) du point d’accès.

(b) Channel Number (Numéro de canal)
Canal de fonctionnement actuel du point d’accès.

(c) Signal Strength (Force du signal)
Force du signal du point d’accès lié.

(a)

(b)

(c)

(d)

(e)

(f)

(g)

Onglet Statistics (Statistiques)
L’onglet « Statistics » (Statistiques) vous indique la quantité de données
envoyées et reçues et si des erreurs se sont produites. Cet écran est utilisé dans
un but de diagnostic. Notez que le nombre de paquets de données perdus est
enregistré. Un nombre élevé de paquets de données perdus peut indiquer un
problème ou la présence d’interférences dans votre zone.

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN
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UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

Page « Diagnostics »
Cette page vous permet d’effectuer plusieurs tests de diagnostic sur la carte
réseau sans fil de Belkin.

« Control Registers » (Contrôler les registres)
Ce test vérifie les possibilités de lecture et d’écriture dans les registres du
contrôleur réseau en y écrivant différentes valeurs, puis en vérifiant les résultats.
Le pilote de périphérique utilise ces registres pour effectuer des fonctions réseau
comme l’envoi et la réception d’informations. Si le test échoue, la carte réseau
ne fonctionne pas correctement.

« SPROM Format Version » (Version du format SPROM)
Ce test vérifie le contenu de la SPROM en lisant une partie de la SPROM et en
calculant le total de contrôle. Le test échoue si le total de contrôle calculé est
différent de celui stocké dans la SPROM.

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

(d) WEP
Affiche « Off » (désactivé) lorsque le cryptage est désactivé, « 64 bits » lorsque
le cryptage sur 64 bits est activé et « 128 bits » lorsque le cryptage sur 128 bits
est activé.

(e) Ad-Hoc Networks Only (Réseaux Ad-Hoc uniquement)
Cochez cette case pour afficher uniquement les réseaux ad-hoc disponibles.

(f) Advanced (Avancé)
Affiche des informations supplémentaires sur le réseau sélectionné.

(g) Freeze (Geler)
Prend un « instantané » de la force du signal au moment de la surveillance du
site. Cliquez à nouveau pour reprendre l’activité.

26 27
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Connexion au réseau impossible
Si la carte semble fonctionner correctement, mais qu’elle ne parvient pas à se
connecter au réseau, cela peut être dû au fait que les paramètres « Network
name (SSID) » (Nom du réseau - SSID) et « Wireless network key (WEP) » (Clé du
réseau sans fil - WEP) ne correspondent pas dans les propriétés du réseau ainsi
que pour le nom et la clé WEP du réseau auquel vous tentez de vous connecter.
Le nom du réseau et la clé WEP font la distinction majuscule/minuscule. Vérifiez
que l’orthographe et la casse de ces paramètres sont corrects et qu’ils sont
parfaitement identiques sur tous les ordinateurs du réseau.

Si, malgré toutes ces vérifications, vous ne parvenez toujours pas à vous
connecter au réseau, reportez-vous à la section « Problèmes de performances et
de connectivité ».

Solution possible
Environnement Windows 2000
Vérifiez que l’option « File and Printer Sharing » (Partage de fichiers
et d’imprimantes) est activée sur tous les ordinateurs du réseau.

Sur le bureau, cliquez sur le bouton « Start » (Démarrer), choisissez
« Settings » (Paramètres), puis « Control Panel » (Panneau de
configuration).

Dans le Panneau de configuration, cliquez deux fois sur l’icône
« Network and Dial-up Connections » (Connexions réseau et accès à
distance).

Dans la fenêtre « Network and Dial-up Connections » (Connexions
réseau et accès à distance), cliquez deux fois sur l’icône « Local Area
Connection » (Connexion réseau local).

Dans la boîte de dialogue « Local Area Connection Status » (État de
la connexion au réseau local), cliquez sur « Properties » (Propriétés).

Dans la boîte de dialogue « Local Area Connection Properties »
(Propriétés de la connexion au réseau local), vérifiez que la case
« File and Printer Sharing for Microsoft Networks » (Partage de
fichiers et d’imprimantes pour les réseaux Microsoft) est cochée. Si
elle ne l’est pas, cochez-la. Si la case n’apparaît pas, cliquez sur
« Install » (Installer). Dans la boîte de dialogue « Select Network
Component Type » (Sélection du type de composant réseau),
sélectionnez « Service », puis cliquez sur « Add » (Ajouter). Dans la
boîte de dialogue « Select Network Service » (Sélection de service
réseau), choisissez « File and Printer Sharing for Microsoft
Networks » (Partage de fichiers et d’imprimantes pour les réseaux
Microsoft), puis cliquez sur « OK ». Fermez la boîte de dialogue

Problème ou
symptôme
Les ordinateurs
semblent communiquer,
mais ils n’apparaissent
pas dans la fenêtre
« My Computer »
(Poste de travail) ni
dans la fenêtre « My
Network Places »
(Favoris réseau).

UTILISATION DE L’UTILITAIRE DE CONFIGURATION DU LAN SANS FIL DE BELKIN

« Memory Tests » (Tests de mémoire)
Ces tests vérifient que la mémoire interne du contrôleur réseau fonctionne
correctement. Le test écrit des matrices de valeurs dans la mémoire et lit les
résultats. Le test échoue si une valeur erronée est lue en retour. Le contrôleur
réseau ne fonctionnera pas sans sa mémoire interne.

« Interrupt Test » (Test d’interruption)
Ce test vérifie que le pilote NDIS est capable de recevoir des interruptions du
contrôleur réseau.

« Loopback Test » (Essai en boucle)
Ce test vérifie que le pilote NDIS est capable d’envoyer des paquets au contrôleur
réseau et d’en recevoir.

LED Test (Test voyant lumineux)
Ce test vérifie que votre matériel réseau sans fil 802.11 fonctionne correctement.
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Le transfert de données est
toujours très lent.

Les ordinateurs ne communiquent
pas avec le réseau.

Sous Windows 2000, j’obtiens le
message suivant : « Medium
cable disconnected » (Câble
média déconnecté). Un X rouge se
trouve également sur l’icône du
réseau dans la barre d’état
système.

Les réseau est vraiment lent
quand le système est connecté à
un réseau sans fil et à un port
Ethernet actif.

Remarque : Pour Windows 2000
uniquement.

Certaines maisons et la plupart des bureaux ont une
structure en acier. Il se peut que l’acier de ces bâtiments
interfère avec les signaux radio de votre réseau, ce qui
ralentit la vitesse de transmission des données. Déplacez
les ordinateurs à un autre endroit du bâtiment pour voir si
le fonctionnement s’en trouve amélioré.

Si votre réseau dispose d’un point d’accès, vérifiez tous les
câbles et assurez-vous que le voyant d’alimentation situé à
l’avant du point d’accès est allumé.

Ceci indique que l’ordinateur n’est pas correctement
configuré pour se connecter au réseau. Vérifiez que tous
les paramètres des propriétés du réseau sans fil sont
corrects. Assurez-vous également que l’ordinateur reçoit un
signal de bonne qualité du point d’accès.

Cette situation se produit si l’ordinateur a un port
Ethernet actif alors que la carte est toujours active et
connectée à un point d’accès. Ceci se produit parce que
Windows 2000 doit maintenant gérer deux connexions
réseau actives. Vous devez soit débrancher le câble
Ethernet de l’ordinateur, soit désactiver la radio sur la
carte. Pour désactiver la radio sur la carte, cliquez avec le
bouton droit de la souris sur l’icône de l’utilitaire sans fil
de Belkin dans la barre d’état système, puis cliquez sur
« Disable Radio » (Désactiver la radio). Remarque : La
radio ne sera pas automatiquement activée au prochain
redémarrage de l’ordinateur. Pour activer la radio, cliquez
avec le bouton droit de la souris sur l’icône de l’utilitaire
sans fil de Belkin, puis cliquez sur « Enable Radio »
(Activer la radio).

Assistance technique
Vous trouverez des informations techniques sur le site
www.networking.belkin.com ou www.belkin.com dans la zone d’assistance
technique. Si vous souhaitez contacter l’assistance technique par téléphone,
appelez le 00 800 223 55 460.
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(Suite)

Les ordinateurs
semblent communiquer,
mais ils n’apparaissent
pas dans la fenêtre
« My Computer » (Poste
de travail) ni dans la
fenêtre « My Network
Places » (Favoris
réseau).

Le transfert de données
est parfois très lent.

« Local Area Connection Properties » (Propriétés de la connexion au
réseau local).

Fermez la boîte de dialogue « Local Area Connection Status » (État
de la connexion au réseau local).

Fermez la fenêtre « Network and Dial-up Connections » (Connexions
réseau et accès à distance).

Environnement Windows XP
Vérifiez que l’option « File and Printer Sharing » (Partage de fichiers
et d’imprimantes) est activée sur tous les ordinateurs du réseau.

Sur le bureau, cliquez sur le bouton « Start » (Démarrer), puis sur
« Control Panel » (Panneau de configuration). Si vous êtes en mode
d’affichage des catégories, cliquez sur « Switch to Classic View »
(Basculer vers l’affichage classique).

Dans « Control Panel » (Panneau de configuration), cliquez sur
l’icône « Network Connections » (Connexions réseau).

Dans la zone « LAN or High-Speed Internet » (Réseau local ou
Internet à haute vitesse), cliquez avec le bouton droit de la souris
sur « Wireless Network Connection » (Connexion réseau sans fil),
puis cliquez sur « Properties » (Propriétés).

Dans la boîte de dialogue « Wireless Network Connection
Properties » (Propriétés de la connexion réseau sans fil), si l’onglet
« General » (Général) n’est pas affiché, cliquez dessus.

Dans la liste « This connection uses the following items » (Cette
connexion utilise les éléments suivants), vérifiez que la case « File
and Printer Sharing for Microsoft Networks » (Partage de fichiers et
d’imprimantes pour les réseaux Microsoft) est cochée. Si elle ne l’est
pas, cochez-la. Si l’élément n’apparaît pas, cliquez sur « Install »
(Installer). Dans la boîte de dialogue « Select Network Component
Type » (Sélection du type de composant réseau), sélectionnez
« Service », puis cliquez sur « Add » (Ajouter). Dans la boîte de
dialogue « Select Network Service » (Sélection de service réseau),
choisissez « File and Printer Sharing for Microsoft Networks » (Partage
de fichiers et d’imprimantes pour les réseaux Microsoft), puis cliquez
sur « OK ». Fermez la boîte de dialogue « Wireless Network
Connection Properties » (Propriétés de la connexion réseau sans fil).

Fermez la fenêtre « Network Connections » (Connexions réseau).

Les fours micro-ondes et certains téléphones sans fil fonctionnent à
la même fréquence radio que les cartes réseau sans fil. Lorsque le
four ou le téléphone est utilisé, il interfère avec le réseau sans fil.
Par conséquent, les ordinateurs équipés de la carte doivent être
installés au moins à 6,50 m d’un four micro-ondes ou d’un
téléphone sans fil qui fonctionne à une fréquence de 2,4 GHz.
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Déclaration FCC

DÉCLARATION DE CONFORMITÉ À LA RÉGLEMENTATION FCC 
EN MATIÈRE DE COMPATIBILITÉ ÉLECTROMAGNÉTIQUE

Nous, Belkin Corporation, sis au 501 West Walnut Street , Compton CA, 90220, États-Unis,
déclarons sous notre seule responsabilité que le produit

F5D7000

auquel se réfère la présente déclaration, est conforme aux normes énoncées à l’alinéa 15 de la
réglementation FCC. Le fonctionnement est assujetti aux deux conditions suivantes : (1) cet
appareil ne peut pas provoquer d’interférence nuisible et (2) cet appareil doit accepter toute
interférence reçue, y compris des interférences pouvant entraîner un fonctionnement non désiré.

Attention : Exposition aux radiations dues aux fréquences radio.

La puissance d’émission en sortie de cet appareil reste largement en dessous des limites
d’exposition aux fréquences radios FCC. Toutefois, il est conseillé d’utiliser l’appareil de manière à
minimiser les risques d’exposition dans des conditions de fonctionnement normales.

Lorsqu’une antenne extérieure est raccordée à l’appareil, le placer de manière à minimiser les
risques d’exposition dans des conditions de fonctionnement normales. Pour éviter la possibilité
d’excéder les limites d’exposition aux fréquences radio FCC, il est conseillé d’éviter qu’une
personne se trouve à moins de 20 cm de l’antenne dans des conditions de fonctionnement
normales.

Avertissement de la Commission des Communications fédérale
L’appareil a été testé et satisfait aux limites de la classe B des appareils numériques, conformément
à la partie 15 de la réglementation FCC. Ces limites sont conçues de manière à assurer une
protection raisonnable contre les interférences nuisibles au sein d’une installation domestique.

L’appareil génère, utilise et peut irradier une énergie radio fréquence. S’il n’est pas installé et
utilisé conformément aux instructions, il peut causer des interférences nuisibles sur le plan de la
réception radio ou télévision, pouvant être déterminées en mettant l’appareil sous et hors
tension. L’utilisateur est invité à tester et à corriger l’interférence en prenant une des mesures
suivantes :

• Réorienter ou changer de place l’antenne de réception.

• Augmenter la distance entre l’appareil et le récepteur.

• Connecter l’appareil à une prise située sur un circuit différent de celui sur lequel le récepteur
est connecté.

• Consulter le revendeur ou un technicien en radio/TV pour obtenir de l’aide.

Modifications
La réglementation FCC souligne la nécessité d’indiquer à l’utilisateur que toute modification, de
quelque nature que ce soit et non agréée par Belkin Components, lui retire le droit d’utiliser
l’appareil.
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Canada - Industry Canada (IC)

La radio sans fil de cet appareil est conforme aux normes RSS 139 & RSS 210 Industry Canada.
This Class B digital complies with Canadian ICES-003.

Europe – Prescription Union européenne
Les produits radio portant le label CE 0682 ou CE alert satisfont 
à la directive R&TTE (1995/5/CE) établie par la Commission de 
la Communauté européenne.

L’accord avec cette directive implique la conformité aux normes européennes suivantes (le
standard international équivalent est indiqué entre parenthèses).

• EN 60950 (IEC60950) – Sécurité des produits

• EN 300 328 Conditions techniques exigées pour les appareils radio

• ETS 300 826 Conditions générales en matière de compatibilité électromagnétique pour les
appareils radio.

Prière de consulter la plaque d’identification apposée sur votre produit Belkin pour déterminer le
type d’émetteur.

Les produits portant le label CE satisfont à la directive relative à la compatibilité
électromagnétique (89/336/EEC) et la directive sur la basse tension (72/23/EEC) publiées par la
Commission de la Communauté européenne. La conformité avec ces normes implique la conformité
avec les normes européennes suivantes (le standard international équivalent est indiqué entre
parenthèses).

• EN 55022 (CISPR 22) – Interférences électromagnétiques

• EN 55024 (IEC61000-4-2,3,4,5,6,8,11)- Immunité électromagnétique

• EN 61000-3-2 (IEC610000-3-2) - Émissions de courants harmoniques

• EN 61000-3-3 (IEC610000) – Fluctuations de tension et flicker

• EN 60950 (IEC60950) – Sécurité des produits

Les produits équipés de transmetteurs radio portent la marque CE 0682 ou CE alert et peuvent
également afficher le logo CE.
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Garantie limitée à vie du produit de Belkin Corporation

Belkin Corporation garantit ce produit contre tout défaut matériel ou de fabrication pendant toute
sa durée de vie. Si l’appareil s’avère défectueux, Belkin le réparera ou le remplacera gratuitement,
à sa convenance, à condition que le produit soit retourné, port payé, pendant la durée de la
garantie, au dépositaire Belkin agréé auprès duquel le produit a été acheté. Une preuve d’achat
peut être exigée.

La présente garantie est caduque si le produit a été endommagé par accident, abus, usage
impropre ou mauvaise application, si le produit a été modifié sans autorisation écrite de Belkin,
ou si un numéro de série Belkin a été supprimé ou rendu illisible.

LA GARANTIE ET LES VOIES DE RECOURS SUSMENTIONNÉES FONT FOI EXCLUSIVEMENT ET
REMPLACENT TOUTES LES AUTRES, ORALES OU ÉCRITES, EXPLICITES OU IMPLICITES. BELKIN
REJETTE EXPRESSÉMENT TOUTES LES GARANTIES IMPLICITES, Y COMPRIS MAIS SANS RESTRICTION,
LES GARANTIES AFFÉRENTES À LA QUALITÉ LOYALE ET MARCHANDE ET À LA POSSIBILITÉ
D’UTILISATION À UNE FIN DONNÉE.

Aucun dépositaire, représentant ou employé de Belkin n’est habilité à apporter des modifications
ou adjonctions à la présente garantie, ni à la proroger.

BELKIN N’EST PAS RESPONSABLE DES DOMMAGES SPÉCIAUX, DIRECTS OU INDIRECTS, DÉCOULANT
D’UNE RUPTURE DE GARANTIE, OU EN VERTU DE TOUTE AUTRE THÉORIE JURIDIQUE, Y COMPRIS
MAIS SANS RESTRICTION LES PERTES DE BÉNÉFICES, TEMPS D’ARRÊT, FONDS DE COMMERCE,
REPROGRAMMATION OU REPRODUCTION DE PROGRAMMES OU DE DONNÉES MÉMORISÉS OU UTILISÉS
AVEC DES PRODUITS BELKIN OU DOMMAGES CAUSÉS À CES PROGRAMMES OU À CES DONNÉES.

Certains pays ne permettent pas d’exclure ou de limiter les dommages accidentels ou consécutifs
ou les exclusions de garanties implicites, de sorte que les limitations d’exclusions ci-dessus ne
s’appliquent pas dans votre cas. La garantie vous confère des droits légaux spécifiques. Vous
pouvez également bénéficier d’autres droits qui varient d’un pays à l’autre.
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Belkin Corporation
501 West Walnut Street

Compton • CA • 90220 • États-Unis
Tél. : 310.898.1100
Fax : 310.898.1111

Belkin Components, Ltd.
Express Business Park

Shipton Way • Rushden • NN10 6GL
Royaume-Uni

Tél. : +44 (0) 1933 35 2000
Fax : +44 (0) 1933 31 2000

Belkin Components B.V.
Starparc Building • Boeing Avenue 333

1119 PH Schiphol-Rijk • Pays-Bas
Tél. : +31 (0) 20 654 7300
Fax : +31 (0) 20 654 7349

Belkin GmbH
Hanebergstrasse 2 •

D-80637 München • Allemagne
Tél. : +49 (0) 89 143 4050

Fax : +49 (0) 89 143 405100

Belkin, Ltd.
7 Bowen Crescent • West Gosford

NSW 2250 • Australie
Tél. :  +61 (0) 2 4372 8600
Fax : +61 (0) 2 4372 8603

Assistance technique Belkin
États-Unis : 310.898.1100 poste 2263

800.223.5546 poste 2263
Europe : 00 800 223 55 460

Australie : 1800 666 040

P74216fr

© 2003 Belkin Corporation. Tous droits réservés. Toutes les raisons commerciales 
sont des marques déposées de leurs fabricants respectifs.

belkin.com
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